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1. Scripting Concept

Automating Desktop and Other Applications

Although Automation Engine already offers a broad set of features and tools to create custom
workflows, it is still possible that you miss some features or that the available features do not
support the native graphics format that you want to run them on.

This is why Automation Engine also offers custom scripting: you can write scripts (small
programs) that typically represent actions that operators do interactively in their graphic desktop
applications..

Once you created that script, the Run Script task enables to insert that task into your normal
workflows. This is how you can automate your desktop applications.

Some examples:

+ To automate actions in desktop applications like Adobe lllustrator, Photoshop, InDesign
(Server), etc. (via ExtendScript on Mac Os and Windows).

+ To convert files into a format that Automation Engine tasks support. For example converting
non-PDF compatible Al files into PDFs.

Supported Script Types

+ AppleScript ( Mac)

+ ShellScript (Mac)

« Batch files (Windows)

+  Windows Script (VBScript, JScript) (Windows)
+ ExtendScript (Mac and Windows)

1 Attention: When scripting Adobe applications, the Script Runner tool on Windows
does not support 64 bit versions of those applications.

The Script Runner Tool

Executing such scripts starts in the Run Script task. One of the settings in that task is to choose if
the script will be executed by a separate Script Runner tool (that you installed earlier on a Mac
or Windows client computer), or if the script can run on the Automation Engine server itself (in
an on-board 'script runner’).

When, for example, your script is a Windows batch file, it will be possible to run it on the
Automation Engine server itself. But when the script needs to interact with a Mac (Adobe)
application, it will require help from a standalone Script Runner that you also installed on that
Mac.

Learn more in The Script Runner Tool on page 5.

Extra Information and Tips available as KB articles

Because the area of scripting is often about customization, the examples in this documentation
do not cover all use cases.
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We therefor advise to also check Esko's Knowledge Base for articles on this topic.


https://www.esko.com/en/Support/Documentation/

Automation Engine

2. The Script Runner Tool

The Automation Engine does not actually run your custom script: the task communicates with
an Automation Engine Script Runner.

A Attention: As mentioned in Scripting Concept, the 'Run Script' task can run the script on
the AE server itself (a Windows Script or batch file) or it could use a standalone Script
Runner tool on a Mac or Windows client.

Here 's an overview of the workflow when a standalone Script Runner tool is used:

AE Server

Run Seript

®//® ®\C?
S

P AE Script AE Script
e

Runner Runner

1. The Run Script task sends a request to run the selected script on its input file(s). The task can
communicate optional script parameters and also defines the output folder for the resulting
file(s).

2. The selected Script Runner processes the request and runs the script.

3. The Script Runner sends the results back to the Run Script task.

4. The workflow continues with the outputs from this Run Script task.
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3. Installing Script Runner

Follow these steps to install the Script Runner tool

1.

Go to the Automation Engine Server Web page, section Client Apps > Tools and Download
Automation Engine Script Runner.

. After downloading, double-click the ‘dmg’ file (Mac) or the 'exe' file (Windows) to start the

installation. Follow the instructions in the Assistant (Mac) or Installshield Wizard (Windows).

. Check the tool's preferences to make sure it is running in that computer:

+ On Windows, open Start > All Programs > Esko > Automation Engine Script Runner
> Preferences .

+ On Mac, open Applications > Automation Engine Script Runner > Esko > Automation
Engine Script Runner > Script Runner Preferences .

In the Script Runner Preferences dialog, you can:

« Start / Stop the Script Runner (or just check if it is running).

Note: On Windows, this will run the Script Runner as a 'Service'. Learn about (the need
for ) other methods in Adobe Applications on Windows: Run Script Runner as an Application
(Not as a Service) on page 33.

+ Enable / disable Start at login
+ View / change the Port that the Script Runner is communicating with

+ View / change the default folders for (types of) scripts.

Example (on Windows):

Start | Script Runner is not running.
|/ Start at login

Port: 1983
Batch Hle Folder: C:\Esko\ba_data_fastserverscrrunnt_v100\Scripts\Batch  [Browse
ExtendScript Folder: =sko\ba_data_fastserverscrrunnt_v100\Scripts\ExtendSeript| Erowss
Windows Script Folder: «o\bg_data_fastserversarrunnt_v100\Soripts\WindowsScript [Erawse

/A Attention: The above shown folders are local, on the Script Runner computer. Learn
how you can (also) store them centrally in Configuring Script Runner on page 7.
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4. Configuring Script Runner

The Automation Engine server needs to know where your Script Runner tool(s) were installed.
You could for example have 2 Macs dedicated to run scripts and also have the Automation Engine
server itself have some Windows scripts or batch files running.

1. Install Script Runner on the client computers that will run scripts. Learn more in Installing
Script Runner on page 6.

2. In a Pilot, go to Tools > Configure .
3. Go to the category Scripts.
4. Now define which computers will run the scripts. Press Insert or choose File > New to add

one.
21 Configure EILEJ
File Edit
# Create DC5 Master ~
t 4% Digital Press Host: EAW11DL306
# E-mail Configuration
+-4 External Databases Port: 1083
+-4 External Web Services P —
# FastImpose Site Preference Test Connection
t # FlexProof - Image Downloi —_—
+|-# FlexRip - Approval
+-# FlexRip - B Avallable Scripts on EAW11DL306:
+-#% FlexRip - BI |
% Flklp - GBI Compact e L
2 EXhIp - Ompa ExtendScript EskoAlPrint.jsx
+ % FlexRip - CDI Spark  00's ExtendScript EskoIDDPrint.jsx
+J. e FIeijg ) ProolferqOutout ExtendScript EskoIDDSaveAsPDF.isx
-F: # FlexRip - Screened Output ExtendScript EskolDServerPrint.jsx
114 FlexRip - Unscreened Outpi ExtendScript EskoIDServerSaveAsPDF. jsx
# Gang Run Printing ExtendScript EskoPSDoActionAndSaveAsIPG.jsx
# Global Vision = Windows Script EskoAcroCallJSFunction.vbs
+-#& Imaging Engines —
+-# Jobs
r g Hgﬁlﬁia“m Awvailable Scripts on Automation Engine:
+-4 Odystar
"2 Pack Proof Servers Type » Name
) g gﬂiﬁgﬂ&ﬂg " ?Emnge_ X ioecI I;lumbels From_Nesting_Report.bat
xtendSarip pplnfo.jsx
H 4% Processing Preferences ExtendSeript EskoAIHelIoWond isx
-+ # Products ExtendScript EskoAlPrint.jsx
i 04 ExtendScript EskoIDDPrint.jsx
m:m ExtendSu'ipt ESROIDDSBVEASPDFJSX
ﬁ_ ?he. eawlldL306 ExtendScript EskolDServerPrint.jsx
# Track Edit Session ExtendScript EskoIDServerSaveAsPDF. jsx
| 2 Viewer ExtendScript EskoPSDoActionAndSaveAsIPG - Mew.jsx
|' -2 Web Proxy ExtendScript EskoPSDoAdtionAndSaveAsIPG. jsx
| |2 WebCenter Sites ExtendScript MyHelloWorld.isx
ExtendScript Save as PDFs.jsx
4 I b

5. Give a suitable name to that Script Runner. Press F2 or choose File > Rename
6. In the Host field, enter the computer name or IP address of the Script Runner computer.
7. Enter the Port used to connect this computer to your Automation Engine server.

By default, this is 1983.

8. Click Test Connection. You should now see a list of all available scripts on that computer or
see a message 'No scripts available'.

These are the scripts that the Run Script Task will let you choose from when you have selected
that Script Runner configuration.
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You can store script on a local (Script Runner) client or centrally on the Automation Engine
server:

Local: You can store scripts on your local client computer on the folder specific for script
type. But note that Automation Engine does not back up these local scripts. It can be useful
however to only have them local when you are still writing and testing a script or when you
do not intend to give access to other Script Runners in your network.

Note: The default location on a client computer is /Library/Scripts/Esko (Mac) and
C:\Esko\bg data fastserverscrrunnt v100\Scripts (Windows).

Central: Alternatively, you can store your scripts in a central Automation Engine system
folder. This option is suitable when you want to make your scripts available to all
configured Script Runners. They will then also be part of your Automation Engine backup.

Note: The  default location on the AE server is C:\Esko
\bg data fastserver v100\Scripts.The subfolder names indicate the type of script.

9. Choose Save (from the menu of the Configure panel).

10.Select the Configure category Scripts (not a configured item, but one level higher). On this
level you see a dialog where you can choose Download Scripts to download all scripts from
all configured Script Runner tool(s) and centralize them onto the Automation Engine server.
This is done to have a central library that will also be part of your server configuration backup.

Note: You will be asked to confirm when local scripts would overwrite central ones.
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5. The Run Script Task

Note: Learn about the concept and the setup of custom scripts in Scripting Concept on page 3.

This task contacts a Script Runner tool to run a script on the input file(s).

}_

- Outputin: | [Job URL] foutput Erowse | []
Run on: _Aummaﬁon Engine - | Configure...

Script Type: .ExbendScript - |

Application: |Adobe Illustrator -

Script File: |EskoPSDoActionAndSaveAsIPG.jsx [1 ~

Script Parameters:
Molten Lead
Default Actions

Add Remove

1. Run on: Choose the Script Runner item that you configured in the Configure panel.
2. Select the Script Type. The types are different, depending if the selected Script Runner runs
on a Mac or a Windows computer:
a) For Mac: You can choose from AppleScript, Shell Script and ExtendScript.
b) For Windows: You can choose from Batch File, ExtendScript, Windows Script and
Windows Script (32-bit).
The type Windows Script will run your script using a 64-bit Windows Script Host on a 64-
bit Windows and a 32-bit 'scripting host' on a 32-bit Windows.

3. Select the Application. This field helps to find the right application, especially when you have
multiple versions installed. The drop down list is a default list that you can edit.

+ On Mac: this is the (original) name of the .app file of that application

+ On Windows: the "Target location" that appears when you ask the "Properties" of that
application. An example:

Tl Adobe Photoshop CC 2014 (32 Bit) Properties o ]

Gengral| Shorlcut Collpaﬁtxlity:SBcurlyl Destails | Previous Viersions

ﬁ Adobe Photoshop CC 2014 (32 Bit)

Target type: Application

Target location | Adobe Photoshop CC 2014 (32 Bit) |

Target dobe Photoshop GG 2014 (32 BityPhotoshop. e

Start in "G\ Program Files (xB8)Adobeihdobe Photoshop O
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Tip: Itis possible that you do not have to enter the full name, but minimally the part that
will help the task to recognize which of the multiple versions you want. For example when
you both have a CS and a CC version, then the year and the bit version do not have to be
mentioned extra (because those are only mentioned after the 'CS' or 'CC' part).

4. Select the Script File. You can select one from the drop-down list, enter a path or/and use
SmartNames.

5. When the script needs one or more optional parameter(s), enter them in Script Parameters.
Click Add and type the parameter.

Note: Learn more details and see some examples in the next pages.

10
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6. Scripting on Mac OS

A Script Runner on Mac OS supports AppleScript and Shell Script to automate operations.

Note:

Sample scripts are provided as-is with no warranty of fitness for a particular purpose. These
scripts are solely intended to demonstrate techniques for accomplishing common tasks.
Additional script logic and error-handling may need to be added to achieve the desired results
in your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is
compliant with any third party license agreement and/or other restrictions applicable to any non-
Esko products.

6.1 AppleScript - Example 1

AppleScript is a scripting language that enables direct control of script-able applications and of
many parts of the Mac OS. An AppleScript-able application is one that makes its operations and
data available in response to AppleScript messages, called Apple events.

We recommend using AppleScript because:

+ itis highly integrated into the Mac OS
+ itis supported by a lot of third party applications
+ itvery accessible to scripting beginners.

1. Open the AppleScript Editor and add following code:

|]_

@& MO Untitled

@ @& N\ =

Record Stop  Run Compile Bundle Contents

AppleScript : <No selected element>

on main(inputs, outputFolder, params)
log "Hello, Worldl"
return "OK"

end main

-

[ Description |-EventLog ]

Option Description

main This function will be called by the Script Runner. Only the code in
this main function gets executed.

inputs The first argument of the main function: a list of input file paths
(type: list of strings).

11
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Option Description

outputFolder Second argument of the main function: the folder where AE expects
the script’s result files. AE will continue the flow with the files you
write in this folder. If you leave this folder empty, AE will continue
the flow with the inputs of the Run Script task (type: string).

params Third argument of the main function: additional script parameters
injected into the script via the Run Script ticket (type: list of strings).

log Extra log information in the Run Script task details.

return “OK” This will communicate to the Run Script task that everything went
fine. Other possibilities are return “Warning” and return
“Error”.

2. Save this code as an AppleScript text file in the Script Runner’s AppleScript folder (default: /
Library/Scripts/Esko/AppleScript) or in the Automation Engine AppleScript folder.

Save As: MyHelloWorld.applescript E]
[« » |22 =|m] |3 AppleScript W (Q
DEVICES (] ColorSync (] AppleScript =
£ MacHD @, (] Esko » | | [ ExtendScript
E iDisk = O ] Folder Action Scripts ] Shell
o ] Folder Actions
SHARED A I_—l Font Book A
PLACES ¥ [ FontSync Scripts 1
i I [ 1 ifrha I
I Deskiop v ' <>
File Format: | Text e ]
Line Endings:  Unix (LF) >
Options: | Run Only || Startup Screen
__| Stay Open
{ New Enldar
[ MNew Folder ) (" cancel ) ( Save )
s

Note: Script Runner supports ‘Text' format. Therefore it is essential to change the file format
to ‘Text.

3. You can add following code to test this script locally in the AppleScript Editor. Save the file and
click Run to execute the script.

12
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on main(inputs, outputFolder, params}
leg "Hello, World!"
return "OK"

end main

on run
== Our main function is not using any of its
arguments, so provide empty ones
set inputs te {} -- empty list
set outputFolder to "" -- empty string
set params to {} -- empty list
main{inputs, outputFolder, params)
end run

[ Description M

on main(inputs, outputFolder, params}
log "Hello, World!"
return "OK"

end main

on run
-- Our main function is not using any of its arguments, so
provide empty ones
set inputs to {} -- empty list
set outputFolder to "" -- empty string
set params to {} -- empty list
main{inputs, cutputFolder, params}
end run

[Events ) | Result

(*Hello, World! =}

Result:
"OK"

[ Description M

Notice the ‘Hello, World! and ‘OK’ result in the event log. The Script Runner does not interpret
the test code in your script. It will execute the contents of the main function and ignore the
rest. You can keep any test code for future local testing.

4. Inthe Pilot, go to Files view where you can select a file and open a New Task. Choose the Run
Script task, modify its settings and launch the task.

13
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Settings for Step: Run Seript

Qutput in: 'BROWSE W]
File Name:
o
Run on: | My Mac Script Runner |5 ]
Script Type: [ AppleScript & ]
Script File: MyHelloWorld.applescript [1 :]

Script Parameters

Learn more in The Run Script Task on page 9.

Note that the ‘Hello, World!" in the task details and ‘OK’ state correspond with 1og “Hello,
World!”’ and ‘return “OK”’ inthe script.

saOe Tasks (RunScriptDema)
= | &3 BB | RunScriptDemo NE) Q-
Made Job MNew Job Search

v VIEWS Job Name File Mame Task Type Progress State  Launched w| TaskID
[ Fies RunScriptDemo Blairon_PDF.pdf Run Script 100% || | 5/23712 3:56 PM 3452 |
[#] To Do List
;_-‘- Pages Task Type: Run Script
= Started on Server: begezingem
g1z Products Started ak 5/23/12 3:56 BM
il Proofs Finished ak 5/23/12 3:56 PM
[=] WebCenter Process Time: 0:00:00
] Plates The scrint's standard output stream:
3 coi Hello, Wiorld!
= The script's error cutput stream:

| ] Task <none>

) Milestones

1 Tickets

6.2 AppleScript - Example 2

In this example, we use AppleScript to copy every input file with a size smaller than the
size specified in the script parameters to the output folder. To do that, we use inputs,
outputFolder and params in the AppleScript.

First, we illustrate how to duplicate files without the size restriction and then we proceed with
the actual case.

1. Open the AppleScript Editor and add the below shown code. This code is aimed to iterate
through the list of inputs. It enables you to handle the inputs one by one, via the ‘input’
variable.

14
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- YoXé) Untitled = |

on main(inputs, outputFolder, params)
== Iterate through the list of inputs
repeat with input in inputs
== Add code here to handle each input
end repeat

return "OK"
end main

Events Replies | @D

[ Description M

4

2. You can modify the Script as shown below to duplicate the files to a specified output folder
without size restrictions. Save this code as an AppleScript text file in the default AppleScript

folder of Script Runner (default: /Library/Scripts/Esko/AppleScript) or in the Automation
Engine AppleScript folder.

| (NN &) MyDuplicate.applescript =)
® '

AppleScn'pt 4 =No selected element:> L.
on main(inputs, outputFolder, params}

== Translate the output folder (UNIX path} into an AppleScript file reference
set outputFolderReference to POSIX file outputFolder

-- Iterate through the list of inputs

repeat with input in inputs
== Translate the input (UNIX path} into an AppleScript file reference
set inputReference to POSIX fife input

== Duplicate input to output folder

tell application "Finder" to duplicate inputReference to outputFolderReference with
replacing
end repeat

return "OK"
end main

Events Replies | LD

"OKR"

[ Description M

3. Add the file size check in the code as shown below. This will duplicate the file when the input
file size is smaller than the maximum size from the script parameters. If this condition is not
met, it will add an entry in the log and there will be "Warning". Save the file.

15
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@00 " MyDuplicate.applescript =

on main{inputs, outputFolder, params)
set returnValue to "OEK"

-- Translate the output folder (UNIX path) into an AppleScript file reference
set outputFolderReference to POSIX file outputFolder

-— Get the maximum size from the script parameters and convert from
megabyte to bytes
set maxSize to (item 1 of params) * 1000000

-- Iterate through the list of inputs

repeat with input in inputs
== Translate the input (UNIX path) into an AppleScript file reference
set inputReference to POSIX file input

-- Get the size of the input
set inputSize to size of (info for inputReference)

-- Check wether the input is OK to duplicate
if ipputSize < maxSize then
-- Duplicate input to output folder
tell application "Finder" to duplicate inputReference to
outputFolderReference with replacing
else
log input & " is too big to duplicate"
set returnValue to "Warning"
end if
end repeat

return returnvalue
end main

-

[ Description |-Enli-l.ng-i

4

4. Inthe Pilot, go to Files view, select the files to be copied and open a New Task. Choose the Run
Script task, modify its settings and launch. This modified ticket will duplicate every selected
file which is smaller than 10MB to the current job's Script Output folder. In this example, we
executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).

16



Automation Engine

Settings for Step: Run Script

Output in: | [Job URL]/ScriptOutput [1
File Name:
a
Run on: [ My Mac Script Runner H-i
Script Type: | AppleScript )
Script File: MyDuplicate.applescript [1 ﬁ

Secript Parameters

‘SmallLabel.pdf’ is duplicated into the job's 'ScriptOutput' folder. ‘BigBox.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in a ‘Warning’ state and added an entry in the

task details.

[ o

Files (RunScriptDemao)

= | & ) | RunScripdemo
Mode

i || Q
Job New Job Search
v VIEWS |v [& RunScriptDemo Name A View | Type Size | Date
» [ Artwork 1 SmallLabel.pdf View PDFFile 89KB 2/10/10 2:16 PM
To Do List > B Esko No
() Pages > i SaptOupu Favorites
EE Products
°| Proofs
Webe [H] begezing: ~ =3 MylobContainer = k] RunScriptDemo = (] ScriptOutput
enter -
E Plates File Name Task Type Progress Phase State Launched Task ID
i col BigBox.pdf,SmallLabel.pdf Run Script 100% M f5/31/12 12:36 PM 3781
Tasks M
Milestones Task Type: Run S.c"m
Started on Server: begezingem
{7 Tickets Started at 5/31/12 12:36 PM
¥ TOOLS Finished at 5731712 12:36 PM
[+7] Devices e
. .
Queue Monitor The script's standard gutput strea.m. ) - . .
_ /Volumes/MyjobContainer/RunScriptDemo/Artwork,/Bigdox.ndf ' is too big to duplicate
L Containers The script's error output stream:
3% Customers <none>
Users e
2 00—
7 Hot Folders
New Task | NewWorkflow Info

1 file Server: begezingem User: admin 0 &

17
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6.3 Shell Script - Example

18

In this example, we use a Shell Script to copy every input file with a size smaller than the specified
size in the script parameters to the output folder.

1. Open atext editor and add the below shown code. When the Script Runner executes this code,
$1 (the script's first argument) will contain a string of input file paths separated by : . The
code splits up the concatenated file paths into a real list. This helps to iterate through the list
and handle the Run Script task's inputs one by one.

® MO @ untitled text ]

o TH 'L':l:_','f (New Document) |¢|_
+  untitled text = . m

]

#!/bin/bash

# Split up the input file paths into a list

# via the Internal Field Separator (IFS)

OLDIFS=%$IFS # Always keep the original IFS

IFS=":" # Now set it to ":'

# Split up '31' into the 'inputs' variable, with ':' as separator
inputs=( %1 )

IFS5=%0LDIFS # Restore the original IFS

inputCount=%{#inputs[@]}

# Iterate through the 1list of inputs
for (( 1=0; i<${inputCount}; i++ ));

do
# Add code here to handle each input
done
exit @
&) <
201 (none} +|Unicode (UTF-8) 4 |Unix (LF} % [ 44372/ 20

2. Write the code as shown below. This script copies the input to the output folder if the input's
file size is smaller than the maximum size from the script parameters. If the size of the file
is bigger, it adds an entry in the log and makes sure the task ends in ‘Warning' state (via exit
value "1"). Save this code as a text file to the Script Runner's Shell folder (default: /Library/
Scripts/Esko/Shell) or to the Automation Engine Shell folder.
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(e NN “| MyCopy.sh -
i 1 d?] = Last Saved: 19/06/12 10:04:19

L/;P \F-['_Inv @ ":_J File Path w : jLibrary/Scripts/Esko/Shell/MyCopy.sh B_l

[ MyCopy.sh = - _——

#!/bin/bash

# Split up the input file paths into a list

# via the Internal Field Separator (IFS)

OLDIFS=%$IFS # Always keep the original IFS

IFS=":" # Now set it to ":'

# Split up '$1" into the 'inputs' variable, with ':' as separator
inputs=( %1 )

IF5=%0LDIFS # Restore the original IFS

inputCount=%{#inputs[@]}

# Get the output folder
outputFolder=%2

# Get the maximum size from the script parameters
# and convert from megabyte to bytes
maxSize="expr $3 \* 1000000°

exitValue=0

# Iterate through the 1list of inputs
for (( i=0; i<${inputCount}; i++ )J;
do
input=%${inputs[$i]}
# Get the size of the input
inputSize="1s -1 "$input" | awk "{print $5}'°

# Check wether the input is 0K to copy

if [ $inputSize -1t $maxSize ]; then
# Copy input to output folder
cp -f "$input” "$SoutputFolder"

else
echo "$input is too big to duplicate”
exitValue=1

fi

done

exit $exitValue

B /4| e
40 |1 Unix Shell Seript % | Unicode (UTF-8) = Unix (LF) % |7 892/ 140/ 40 i
$1 First Shell Script argument: the Run Script task’s inputs. A string of input
file paths, separated by /",
$2 Second Shell Script argument or output folder: This is the folder where

Automation Engine expects the script's result files. AE will continue the
flow with the files you write in this folder. If you leave this folder empty,
AE will continue the flow with the inputs of the Run Script task.

$3, 4, $5,...| Remaining Shell Script arguments: additional script parameters which
you can inject into the script via the Run Script task.
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exitvalue Ending Status of the task
0 OK

1 Warning

2 Error

3. In the Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,
modify its settings and launch. This modified ticket will duplicate every selected file which is
smaller than 10MB to the current job's Script Output folder. In this example, we executed this
task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).

Settings for Step: Run Script

Qutput in: [Job URL]/ScriptQutput BROWSE W W]
File Name:
o
Runon: | My Mac Script Runner | 3 ]
Script Type: | Shell Script s ]
Script File: MyCopy.sh [1 j

Script Parameters

‘SmallLabel.pdf’ is duplicated into the job's Script Output folder. ‘BigBox.pdf’ was too big to
duplicate (> 1T0MB). Therefore, the task ended in ‘Warning’ state (due to exitvalue=1 in the
code) and added an entry in the task details.
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Queue Monitor
E Containers
3% Customers

L Users

(| Hot Folders

The script's standard output stream:
{Volumes/MyJobContainer/RunScriptDemo,Artwork/BicBax.pdf is too big to duplicate

o000 Files (RunScriptDema)
E | [ RunScriptDemo = ] [ . | ] q D!
Mode Job New Job Search
¥ VIEWS ¥ [l RunScriptDemo Name 4 view | Type | Size | Date
» [ Artwork ) SmallLabel .pdf View PDFFile 89KB 2/10/10 2:16 PM
To Do List > B Esko No
() Pages > i ScriprOupue Favorites
EE Products
Proofs — - - - -
begezing: = 5J MyJobContainer * [i] RunScriptDemo * [ ScriptQutput
@ WebCenter =
E Plates File Name | Task Type | Progress | Phase | State | Launched | Task ID
3 cor BigBox.pdf,SmallLabel.pdf Run script 100% [0 5/31/12 12:36 PM 3781
Tasks
Task Type: Run Script
Misstones Started on Server: begezingem
(1] Tickets Started at 5/31/12 12:36 PM
¥ TOOLS Finished ac 5/31/12 12:36 PM
|E| et s Process Time: 0:00:00

The script's error output stream:

<nonez

P

New Task

2y &) @

Mew Worlkflow

Info

1 file

Server: begezingem User: admin [ 0 %
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7. Scripting

Automation Engine

on Windows

A Script Runner on Windows supports Windows Scripts and Batch files. We recommend Windows
Script for its scripting abilities comparable to batch files, its wider range of supported features
and the simpler syntax. Windows Script is plain-text VBScript or JScript which is interpreted and
run by the Windows Script Host.

7.1 Windows Sc

ript Example 1

1. Open a text editor and add the below shown code:

g *new 1- Notepad++ [ =HEC &r
File Edit 5earch View Enceding Language Settings Macro Run  Plugins Window 2 X
o HHEB 0¢LB]| Q|é’) |ﬁﬁbﬁ|% 3|'—'|."3_|.|'=_+' ‘-J -
= new 1 l
zZ Function Main({inputs, outputFolder, params)
4 WScript.Echo "Hello, World!"™
; ' S5et the function's return value.
7 Main = "OEK"
8 End Function !
length:148 Ln:6 Col:39 Sel:0 Dos\Windows AMSI INS
Function Main The function that will be called by the Script Runner. Script
Runner executes only the code in this main function.
inputs First argument of main function: a list of input file paths (type:
list of strings).
outputFolder Second argument of the main function: the folder where AE
expects the script's result files. AE will continue the flow with the
files you write in this folder. If you leave this folder empty, AE will
continue the flow with the inputs of the Run Script task (type:
string).
params Third argument of the main function: additional script
parameters injected into the script via the Run Script ticket (type:
list of strings).
WScript.Echo This puts some extra log info in the Run Script task details and
log. This call prints text to the Console and adds a newline
character without Script Runner context.
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Main = “OK” This communicates to the Run Script task that everything went
fine. Other possibilities are Main = “Warning” andMain =
“Error”.

2. You can test this script locally by adding the code shown below. Save this file. Open
command prompt.Change the directory to the script’s parent directory. Run command ‘cscript
MyHelloWorld.vbs'.

|
| *C:\Esko\bg_data fastser PE\MyHelloWorld.vbs .. 0| ). e
File Edit 5earch View Enceding Language Settings Macro Run  Plugins Window 2 X
= " Le b A A = =
cEHEHB 0--@@1|ﬂémﬁ|@ |ﬁll E|%'3|'—'.'—‘. =7 -le
= MyHelloWarld vbs l
2
= Function Main({inputs, outputFolder, params)
4 WScript.Echo "Hello, World!"™
5
& ' Set the function's return value.
7 Main = "CK"
8 End Function
9
10 ' Cur main function is not using any of its arguments,
11 ' so provide empty ones.
12 Dim inputs()
13 Dim cutputFolder
14 Dim params()
1L Main inputs, outputFolder, params
16 |
i 1] | 3
length:314 Ln:16 Col:1 Sel:164 Dos\Windows ANSI INS
|

This will produce the output ‘Hello, World! to the console. The Script Runner does notinterpret
the test code in your script. It will execute the contents of the main function and ignore the
rest. You can keep your test code for future local testing.

3. In a Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,
modify its settings and launch the task.
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Settings for Step: Run Seript

Qutput in: 'BROWSE JW]
File Name:
a
Run on: | My Win Script Runner |5 ]
Script Type: | Windows Script B!
Script File: MyHelloWorld.vbs [1 :]

Script Parameters

Note that the ‘Hello, World!" in the task details and ‘OK’ state are corresponding with
WScript.Echo “Hello, World!” andMain = “OK” in the script.

amo Tasks (RunScriptDema)
E .| l RunScriptDemao = ] [ +M ] Q-
Mode Job New Job Search
w VIEWS 'n_h Job Name File Mame Task Type Progress Phase | State Launched v| Task ID
[ Files RunScriptDemo  Blairon.pdf  Run Script  100% 6/6/12 11:07 AM 3865
To Do List Task Type: Run Script
Ea Pages Started on Server: begezingem
2 products Started at: 6/6/12 11:07 AM
Proofs Fumsh&FJ ak 6/6/12 11:07 AM
Process Time: 0:00:00
WebCenter .
The script's standard output stream:
@ Plates Microsoft (R) Windows Script Host Version 5.8
E ol Copyright (C) Microsoft Corporation. All rights reserved.
—%*L Hello, World!
RIELSIUNES The script's error output stream:
| Tickets <none>
1 of 1 selected Server: begezingem User: admin 0

7.2 Windows Script Example 2

In this example, we use Windows Script to copy every input file with a size smaller than the
size specified in the script parameters to the output folder. We use inputs, outputFolder and
params in the script to achieve our objective.

First, we illustrate how to duplicate files without the size restriction and then we proceed with
the actual example.

1. Open a text editor and add the below shown code. This code is aimed to iterate through the
list of inputs. It enables you to handle the inputs one by one, via the ‘input’ variable.
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[ b
[of "new 2 - Notepad++ 1 E@ﬂ
e
Eile Edit Search View Encoding Language Settings Macre Run  Plugins  Window 2 X
> T = = | = *»
cHEHBzGE smMDoe|ihyl 2tz RBRE|I=1ES
= new 2 |
2 HFunction Main(inputs, outputFolder, params)
4 r ' Iterate through the list of inputs.
5 H For Each input In inputs
6 r ' Add code here to handle each input.
7 Hext
9 ' Set the function's return value.
10 - Main = "OH"
11 End Function
| |
1 i 3
length:257 Ln:10 Col:16 Sel:0 Dos\Windows ANSI INS

2. You can modify the Script as shown below to duplicate the files to a specified
output folder without size restrictions. Save this code as a text file with ‘vbs'
extension (VBScript) in the Windows Script folder of Script Runner (default: C:\Esko
\bg_data_fastserverscrrunnt_v100\Scripts\WindowsScript) or in the Automation Engine
WindowsScript folder.
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T CAEsko\bg,data MyCopywbs - Notepad++ (s o0 e
File Edit 5earch View Encoding Language Settings Macre Run  Pluging  Window 7 X
cHEHE R LElsimD|ecinhl 22 BEIZITIED 97
= MyCopy.vbs |

1
2 ElFunction Main(inputs, outputFolder, params)
= "
4 - ' Create the file system object that is going to do the copying.
& Dim filesys
& S5et filesys = Createlbject("Scripting.FileSystemlbject™)
T 3 WScript .Echo "File system object created"”
B8
9 - ' Iterate through the list of inputs.
10 B For Each input In inputs
11 ' Copy input to output folder.
12 - Dim outputFile
13 outputFile = outputFolder & "\" & filesys.GetFileName (input)
14 B filesys.CopyFile input, autputFila
15 Hext
16
17 ' Set the function's return value.
18 7 Main = "CK"
o End Function
20
4 | I | 3
length: 578 lines:20 Ln:14 Col:43 5el:0 Dos\Windows ANSI M5

3. Add the file size check in the code as shown below. This will duplicate the file when the input
file size is smaller than the maximum size from the script parameters. If this condition is not
met it will add an entry in the log and there will be "Warning". Save the file.
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F B
g *C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\WindowsScript\MyCopy.vbs - Notepad++ @M
File Edit 5earch View Enceding Language Settings Macro Run  Plugins Window 2 X

5 ey =3 =
cHEB LB iRl tx B EREER 7
=] Mﬁhpyybsl
2 EEhnctian Main(inputs, outputFolder, params)
3 = Dim returnValue
1 returnValue = "CQE"
5
& ' Get the maximum size from the script parameters

' and convert from megabyte to bytes.
Dim maxSize
maxS5ize = params(0) * 1000000

F
U T+ & -1

- ' Create the file system object that is going to do the copying.

Dim filesys
S5et filesys = Createlbject("Scripting.FileSystemCbject™)
= WScript.Echo "File system object created®

- ' Iterate through the list of inputs.

I I R R
-] MmN s R

Hext

[T VT

' Set the function's return value.

[}
r

Main = returnValues
End Function

1 = For Each input In inputs

18 ' Turn the input path into a file cbject.

19 Dim inputReference

20 Set inputReference = filesys.GetFile (input)

21

22 ' Check wether the input is CE to copy.

23 B If inputReference.3ize < maxSize Then

24 ' Copy input to output folder.

25 Dim outputFile

26 outputFile = outputFolder & "\" & filesys.GetFileName (input)
27 - filesys.CopyFile input, outputFile

28 B El=e

29 WScript.Echo input & " 1s too big to copy"”
30 - returnValue = "Warning"

= B End If

-1 o

4 [0 | 3

length : 1046 lines: 37 Ln:31 Col:15 5el:0 Dos\Windows ANSI M5

4. In a Pilot, go to Files view, select the files to be copied and open a New Task. Choose the Run
Script task, modify its settings and launch. This modified ticket will duplicate every selected
file which is smaller than 10MB to the current job's 'ScriptOutput' folder. In this example, we
executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).
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Settings for Step: Run Script
Qutput in: [ob URL]/ScriptOutput EROWSE ¥
File Name: R
2

Run on: | My Win Script Runner I':-]

Script Type: [ Windows Script P:-]

Script File: MyCopy.vbs [1 ﬁ

Script Parameters

4+ | =

‘SmallLabel.pdf’ is duplicated into the job's 'ScriptOutput' folder. ‘BigBox.pdf’ was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning' state and added an entry in the

task details.
800 Files (RunScriptDamo)
E | [ RunScriptDemo :] [ +M J 'Q,
Mode Job Mew Job Search

¥ VIEWS '_r ¥ [ RunScriptDemo | Name Al View | T.. Size Date

d:h_( b [ Artwork ) SmallLabel.pdf view P.. 83KB 2/10/... No
To Do List > @lEsko Favorites
o » [ ScriptOutput

AgQes
92 products (=] - 3 My = L] RunScriptDemo = [ SeriptOutput
Proofs File Name Task Type Progress Phase 2 Launched Task ID
- BEBEX.Edf, Run Script 100% : i_ 6/6/12 4:2... 3866
Details
@ Plates
@ DI Task Type: Run Script n
y Started on Server: begezingem

Tasks Started at: 6/6/12 4:27 PM
Milestones Finished ac 6/6/12 4:27 PM
7 Tickets Process Time: 0:00:00

¥ TOOLS The script's standard output stream:

i Microsoft (R) Windows Script Host Version 5.8
(5] Devices Copyright (C) Microsoft Corporation. All rights reserved.
|_ Queue Monitor
E Containers < File syslgm object created . . . .
=\ \begezingem'MyJobContainer\RunscriptDemo’\ Artwork\Bj qu(_pdf is too big to copy
E?’- EURIEG T [ The script's error output stream:
<none> y

7.3 Batch File Example

1. Open a text editor and add the below shown code. This code is aimed to iterate through the
list of inputs. It enables you to handle the inputs one by one, via the command %1 (the script's
first argument) will contain a string of input file paths, separated by ‘;".
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= —
[Cf *rew 1- Notepad-~ R TR o=

File Edit 5earch View Encoding Language Settings Macre Run  Pluging  Window 7 X
BB LBl saDloeciawtBREISITIEQIED®EE@E 7
=] mw1|

1 Gecho off

rem First script argument contains the input file paths
set inputs=%1

rem Trim surrounding gquotes

for /f "usebackg tokens=*" %%a in ('%inputs%') do set inputs=%%-~a

set exitValue=0

M =1 m N W R

LT

S5 rem Iterate through the input file paths which are separated by ';
10 : ITERATE INPUTS

11 if "%inputs%"=—"" goto EXIT

12 for /f "tokens=1 delims=;" %%a in ("%inputs%") do eall :HANDLE INPUT "%%a"
12 for /f "tokens=1l* delims=;" %%a in ("%input=%") do set inputs=%%b

14 gote ITERATE INPUTS

15

16 :HANDLE INPUT

17 echo BRdd code here to handle each input

| 18 gote :eof

19
20 EXIT
21 exit %exitValue®
22
Bate length: 575  lines: 22 Ln:22 Col:1 Sel:0 Dos\Windows ANSI M5

2. You can modify the Script as shown below to duplicate the files to a specified output folder
with a size check. Save this code as a text file with *. bat’ extension in the Script Runner Batch
File Folder (default: C:\Esko\bg_data_fastserverscrrunnt_v100\Scripts\BatchFile) or in the
Automation Engine 'BatchFile' folder.
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[ CAEsko\bg_data, fastserversTunnt vIOOGHpEABatch\myCopy.bat - Notepari s+ T I || ol I

File Edit 5earch View Encoding Language Settings Macre Run  Pluging  Window 7 X
cHEHGB LB saD|loc|ihgl ¢tz BRI I1EDEEN®E 7
= myCopybat |
1 Gecho off
2 rem First script argument contains the input file paths
2 set inputs=%1
4 rem Trim surrounding quotes
3 for /f "usebackg tokens=*" %%a in ('%inputs%") do set inputs=%%~a
&
7 rem Get the output folder
8 =et outputFolder=%2
9
10 rem Get the maximum size from the script parameters
11 rem and convert from megabyte to bytes
12 set /a maxSize=%3*1000000
13
14 s=et exitValue=0
15
1& rem Iterate through the input file paths which are separated by ";"
17 : ITERATE INPUTS
18 if "%inputs%"=—"" goto EXIT
1% for /f "tokens=1 delims=;" %%a in ("%inputs%") do eall :HANDLE INPUT "%%a"
20 for /f "tokens=1* delims=;" %%z in ("%input=s%") do set inputs=%ib
21 gote ITERATE INFUTS
22
23 :HANDLE INPUT
24 rem Get the size of the input
25 for %%? in (%l) deo set inputSize=%%~z? 1]
26 rem Check wether the input is OE to copy
27 if %inputSize% lss ¥maxSize® (
28 rem Copy input to output folder
29 copy /v %1 %outputFeolder%
20 ) else |
31 echo %1 is too big to copy
3z set exitValue=1
33 )
24 goto :eof [
35
36 EXIT
37 exit %exitValue® I
28 |
4 Tt | 3
Bat¢ length: 973 lines: 38 Ln:38 Col:1 Sel:0 Dos\Windows ANSI INS
%1 First batch file argument: the Run Script task’s inputs. A string of input file
paths, separated by ;".
$2 Second batch file argument or output folder: the folder where AE expects
the script’s result files. AE will continue the flow with the files you write in
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this folder. If you leave this folder empty, AE will continue the flow with
the inputs of the Run Script task.

Remaining batch file arguments: additional script parameters, injected
into the script via the Run Script task.

ul

o° o
w

M ~
o\°
D

~

Exit Ending Status of the task
value

0 OK

1 Warning

2 Error

3. In aPilot, go to Files view, select the files to be copied and open a New Task. Choose the Run

Script task, modify its settings and launch. This modified ticket will duplicate every selected
file which is smaller than 10MB to the current job's Script Output folder. In this example, we
executed this task for two files (BigBox.pdf: 22MB and SmallLabel.pdf: <1MB).

Settings for Step: Run Script

Qutput in: [ob URL]/ScriptQutput BROWSE W W]
File Name:
2
Run on: | My Win Script Runner | & ]
Script Type: | Batch File o ]
Script File: myCopy.bat [1 j

Script Parameters

‘SmallLabel.pdf’ is duplicated into the job's 'ScriptOutput' folder. ‘BigBox.pdf' was too big to
duplicate (> 10MB). Therefore, the task ended in ‘Warning’ state and added an entry in the
task details.
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80O

{a]ia)

¥ VIEWS

To Do List
@ Pages

EE Products

@ WebCenter

E Plates

[£] coi

Tasks
Milestones
11 Tickets

¥ TOOLS

|E| Devices

Queue Moni...

Files {(RunScriptDemo)

ri = +N Q-
¥ [u] RunScriptDemo View Size
» [ Arwork ) SmallLabel.pdf view 89KB o
» [ Esko E it
» [ ScriptOutput avorites
[=] - &3 » & RunScript = (] ScriptOQutput
File Name Task Type Progress Phase State Task ID
BigBox.pdf,SmallLabel. R pt_100 :
000 Details

Task Type: Run Seript
Started on Server: begezingem
Started at: 6/27/12 10:44 AM
Finished ar: 6/27/12 10:44 AM
Process Time: 0:00:00

The script's standard output stream:

"\\begezingem\MyJobContainer\RunScriptDemo\Artwork\BinBox.pdf is too big to copy

o | 1 file(s) copied.
+ | The script's error output stream:
<none:
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8. Using ExtendScript (Mac & Windows)

8.1 Adobe Applications on Windows: Run Script Runner

as an Application (Not as a Service)

When you use ExtendScript on Windows, you can avoid troubles while accessing your user
specific settings such as Adobe applications' Presets, Actions etc. by stopping the Script Runner
service and running it as an application for the logged in user (who also defined the Adobe
settings).

Follow these steps to do this:

+ Open Start > All Programs > Esko > Automation Engine Script Runner > Preferences .

« Stop the Script Runner and deselect Start at login (which actually means ‘Start as service’)
and Close Preferences.

« Start it as a console application by double clicking its executable in the
Script Runner’'s program folder >\bin ix86\egscrrun.exe. For example C:\Esko
\bg prog fastserverscrrunnt v141\bin ix86\egscrrun.exe

8.2 ExtendScript in Adobe lllustrator - Example 1

ExtendScript is JavaScript extended for Adobe CS/CC applications. Adobe provides the
ExtendScript Toolkit (ESTK): a complete IDE (integrated development environment) to program
ExtendScript. Learn more about Adobe scripting resources in the Adobe Scripting Center.

1 Attention: As mentioned in the introduction, Windows 64 bit applications are not
supported on a standalone Script Runner tool.

1. Open the ExtendScript Toolkit and add the below shown code. Save this code in the Script
Runner’s ExtendScript folder. The default location is : /Library/Scripts/Esko/ExtendScript
for a Script Runner on Mac or C:\Esko\bg data_fastserverscrrunnt_v100\Scripts
\ExtendScript on Windows. Alternatively, you can save them in the ExtendScript folder of
Automation Engine.
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® * Sourcel
&3 [ Asobe llustrator GS5.1 [ B P W > Y A S
=
1 function main (inputs, outputfolder, params}
2
3 $oariteln ("Hello, World!");
4 alert ("Another way to say: Hello, Waorld!");
5 return "OK";
& }
7 =
| = 3 i
| Line 7 Column 1
Main This function will be called by the Script Runner. Only the code in
this main function gets executed.
Inputs First argument of main function: a list of input file paths (type: list of
strings).

outputFolder Second argument of the main function: the folder where AE expects
the script’s result files. AE will continue the flow with the files you
write in this folder. If you leave this folder empty, AE will continue
the flow with the inputs of the Run Script task (type: string).

params Third argument of main function: additional script parameters,
injected into the script via the Run Script ticket (type: list of strings).
$.writeln This writes extra log information in the Run Script task details

and log. Without Script Runner context this call prints text to the
Console, and adds a newline character.

alert This registers some extra log info in the Run Script task details and
log. Without Script Runner context this call displays an alert box.

return “OK”; This communicates to the Run Script task that everything went
fine. Other possibilities are Return = “Warning” and Return =
“Error”.

2. To test the script locally in the ExtendScript Toolkit, add below shown code, save and run the
script.
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c

Adobe llustrator G85.1 main

function main (inputs, outputFolder, params)
{
$.writeln ("Hello, World!");
alert ("Another way to say: Hello, World!");
return "OK";
}

// Our main function is not using any of its arguments, so you can test main without arguments
main ();

=

RIS

As a result, ‘Hello, World! and ‘OK’ are shown in the Console and the alert box pops up:

Another way to say: Hello, World!
Hesult: OK

o)

The Script Runner does not interpret the test code in your script. It will execute only the
contents of the main function and ignore the rest. You can keep your test code for future local
testing.

. In the Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,
modify its settings and launch the task.

Settings for Step: Run Script

Output in: |

Qa File Name:
Run on: [ My Mac Script Runner H
Script Type: [ ExtendScript H
Application: |Adobe lllustrator !
Script File: | MyHelloWorld.jsx [1 o)

Script Parameters

+] -]
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Note that the ‘Hello, World!" in the task details and ‘OK’ state are corresponding with
$.writeln("Hello World!")and Return = “OK” in the script.

L Na N Tasks (RunScriptDemo)
E g8 . | [ RunScriptDemo = l [ +M l Q-
Mode Job New Job Search
¥ VIEWS & Job Name File Mame Task Type Progress Phase | State Launched v| Task ID
) Files RunScriptDemo  Blairon.pdf  Run Script  100% [ | 6/4/12 2:11 PM 3788
To Do List
Task Type: Run Script
ﬁa Pages Started on Server: begezingem
45 Products Started at: 6/4/12 2:11 PM

+| Proofs Finished av: 6/4/12 2:11 PM

WebCenter Process Time: 0:00:01

— The script's standard output stream:
ﬂ Plates

Hello, World!
coi Another way to say: Hello, World!
-ﬂ_“ \L| The script's error output stream:
Milestones <nonez
11 Tickets

v TOOLS = g =
|E|Devices- }f _:"lj_l E% @

v Relaunch @ Move to History Delete

= Bl it

1 of 1 selected Server: begezingem User: admin 0

8.3 ExtendScript in Adobe lllustrator - Example 2

Note: Make sure you read this page first: Adobe Applications on Windows: Run Script Runner as an
Application (Not as a Service) on page 33.

Note: To prevent having to start up the Script Runner every time you log in, add its executable
to your user’s/system’s Startup Items.

1. Define a My Print Preset in your Adobe lllustrator application.

2. Open the ExtendScript Toolkit and add the below shown code. This code is aimed to iterate
through the list of inputs. It enables you to handle the inputs one by one, via the input
variable.
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-

ExtandScript Toolkit CS5.5 main

function main(inputs, outputFolder, params)

={
// Iterate through the list of inputs.
for (i=0; i<inputs.length; i++)
2 {

var input = inputs[i];

// Add code here to handle each input.
}

return "OK";

RIS

3. To print every input file using a Print Preset from the script parameters in the Run Script
task, write the code as shown below. Save this code in the default ExtendScript folder (of Script
Runner or of Automation Engine).
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ExtendScript Toolkit C85.5 main

function main{inputs, outputFolder, params)
=L
// First and only script parameter is the print preset.
var printPreset = params[0];

var returnValue = "OK";

// Tterate through the list of inputs.
for (i=0; i<inputs.length; i++)
=

var input = inputs[i];

try

= {

// Open the input file.

var myDocument = app.open{File{input), DocumentColorSpace.CMYK);
// Create print options and set the print preset.

var options = new PrintOptions();
options.printPreset = printPreset;

// Print the document,

myDocument.print(options);

// Close the document without saving.
myDocument.close(SaveOptions .DONOTSAVECHANGES);
i }

catch (e)

= {

// Log problem info and set the return value to "Warning".
$.writeln{"Problem while printing " + input);
$.writeln{"Name: " + e.name);

$.writeln{"Message: " + e.message);

returnValue = "Warning";

i }

}

return returnValue;

|
RN
N 1

4. In a Pilot, go to Files view, select a file and open a New Task. Choose the Run Script task,
modify its settings and launch the task.
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Settings for Step: Run Script

.' Output in: [1
Qa File Name:
Run on: | My Mac Script Runner |5 ]
Script Type: | ExtendScript s ]
Application: Adobe lllustrator ﬂ
Script File: MyPrint.jsx [1 j

Script Parameters

Print Preset

I

Launching this ticket will print the selected Illustrator files using the Print Preset specified as
script parameters (My Print Preset)inthe task.

8.4 ExtendScript in Adobe Photoshop - Example

Note:

Sample scripts are solely intended to demonstrate techniques for accomplishing common tasks.
Additional script logic and error-handling may need to be added to achieve the desired results
in your specific environment.

It is up to the user to verify that his intended use of the offered automation functionality is
compliant with any third party license agreement and/or other restrictions applicable to any non-
Esko products.

In this example, we illustrate a script that performs a Photoshop "action" and then
produces a JPEG output. The script 'EskoPSDoActionAndSaveas)PG.jsx' is available from the
sample scripts subfolder "ExtendScript" in /Library/Scripts/Esko (Mac) or C:\Esko
\bg data fastserverscrrunnt v100\Scripts (Windows).

1. You have to save the Set and Action in Photoshop. In this example we are using an action
named "Molten Lead" which is one of the "Default Actions" (folder) as Set (variable 2)
and "Molten Lead" as Action (variable 1).

2. You can open the script with ExtendScript Toolkit to edit the script if required. However, in this
sample, we do not need to edit the script.
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* Sample scripts are provided as-is with ne warranty of fitness for a particular purpase.

* These scripts are solely intended te demenstrate techniques for accomplishing comman tashs.

* Additional script logic and error-handling may need to be added te achieve the desired results in your specific environment.

* Itis up to the user to verify that his intended use of the offered automation functionality is compliant with any third party license agreement and/or other
)

function main(inputs, cutputfolder, parmms)
{

E for (i=0;i<inputs.length;i++)

H{

var flleRef = new Flle{inputs[i1);
var docRef = app.open(fileRef);

app.doAction{parmms[0], parmms[1 ])d

outputFile = new File{outputFolder + “/" + fileRef.name);
jpgSaveOptions = new JPEGSaveOptions ();
jpgSaveOptions.embedColorProfile = true;
jpgSaveOptions.formatOptions = FormatOptions .STANDARDBASELINE;
jpgSaveOptions.matte = MatteType.NONE;
jpgSaveOptions.guality = 1;
docRef.saveAs (outputFile, jpgSaveOptions, true, Extension.LOWERCASE);
docRef.close (SaveOptions .DONOTSAVECHANGES);

H

return "OK"

-2

3. Edit the settings of the Run Script task as shown below:

Settings for Step: Run Script

" Qutput in:  [Job URL]/output [ BROWSE JI]
File Name
a
Run on: | ShaletMAC ﬂ

a)
v

Script Type: | ExtendScript

Application: Adobe Photoshaop CS3 L}

Script File: 'EskoPSDoAcr‘sonAndSaveAsJPC‘jsx [l 3

Script Parameters
Molten Lead
Default Actions

+

a) Run on: is the name of the computer where your Automation Engine ScriptRunner is
installed. The name in this example is ShaletMac. Learn more about configuring and
naming a Script Runner in Configuring Script Runner on page 7.

b) Script Type: choose ExtendScript.

¢) Script File: choose EskoPSDoActionAndSaveasJPG. jsx.

d) Script Parameters: Add the name of your Photoshop Action name followed by your Set.
In this example, Molten Lead; Default Actions

e) Save the task ticket.

4. Launch the task:

a) Select a Photoshop file.

b) Right-click the file and browse for the ticket.

¢) Click Launch.

You will see that while the script starts to run on the Automation Engine Server, Photoshop
opens, performs the actions, closes and continues the script. The result of this sample script
is an adjusted jpeg.
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9. Script Samples

Click this link to download a PDF containing some samples of scripts.

Automation Engine
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http://help.esko.com/docs/en-us/automationengine/16/userguide/pdf/ae_Scripting_Samples.pdf
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